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Learning outcomes for today RSN

+ Understand more about the advanced functionality in Mercury and how it can be used to visualise,
analyse and compare solid forms effectively, including guidance on:
o Applications of the new disorder visualization feature.
o Edit structures, select, hide or delete parts of the structure and create your own style!

o Structure and molecule overlay, for comparing crystal structures packing and molecular conformations and
stereochemistry.

o Visualize a slice of the crystal packing along BFDH planes.
o Conformer generator for generating plausible conformers of compounds of interest.
o Programmatic access though CSD Python APl menu - no need for coding with the pre-loaded functionality!

* Learn tips and tricks for using a range of tools effectively to save you time and help you advance your
research

« Gain confidence in the functionality used today so you can apply the technigues on your own
systems/structures.

CCDC



The Cambridge Structural Database = -

Number of structures in the CSD
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Year

Every published structure
* Inc. ASAP & early view
« CSD Communications
« Patents
* University repositories
* Thesis

Every entry enriched and
annotated by experts

Discoverability of data
and knowledge

Sustainable for over 58
years

A trusted CoreTrustSeal
repository

CORE ~ertified as Trus :
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SEAL by CoreTrustSeal
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Inside the Cambridge Structural Databa'ée”.
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Organic Additional data

YANTA 55% Agrochemicals R KSRt 174,987 melting points
At least one transition metal, Dig ments L | B 1,075,904 Crystal colours

lanthanide, actinide or any of Al, .
Ga, In, Tl, Ge, Sn, Pb, Sb, Bi, Po Explosives 951,746 crystal shapes

Protein ligands : 3 30,275 bioactivity details
13,641 natural source data
Metal-Organic > 350,000 oxidation states

Not Polymeric
899% Metal Organic Frameworks

Models for new catalysts & Links and subsets

Porous frameworks for gas storage d DrugBank

Fundamental chemical bonding 9 Druglike

- . 9 MOFs
Single Multi e e N sE8E " PDB ligands

j _ P 4 ,“. WES @ N 5 5
Component Component ; , rsipuoe PR g PubChem
58% 42% " a5 Py
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ChemSpider
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The vision

BERNAL'S VISION: FROM
DATA TO INSIGHT

by Dr Olga Kennard OBE FRS

THE J D BERNAL LECTURE 1995
delivered at
BIRKBECK COLLEGE, LONDON

goRge
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We clearly recognised even in those early days, that data banks have three

principal functions.
and make it readily available to the scientific community.

Firstly they must gather together existing knowiedge|

Secondly they

can be used to reduce a large number of observations to a small set of
constants and rules, and in this way transform a data base to a knowledge

base.

Such a knowledge base may obviate the need for further individual

experiments in specific areas.

Thirdly, they facilitate the comparison and
collective analysis of individual results to gain insight into new or as yet

unexplained phenomena.
of the Cambridge Crystallographic Data Centre and the

I'hese ideas have been at the heart of the work

driving force for

improving methods of data collection, storage and dissemination. Most
importantly they influenced development of computer programs and
methodologies which are needed for the analysis and transformation of the

accumulated information. (5)

CCDC




The CSD Portfolio today

CSDCore Search, visualise, analyse and communicate structural data ii'f %
* Insights into molecular and crystal shape and interactions ,_,( g

CSDDiscovery. CSDMaterials. CSDParticle. Theory.

Design of new molecules Assessment of solid form Anticipate particle properties Insights from predicted
stability and properties and behaviour structure landscapes

Mean H-Bond Propensiy
3 04 05 08 07 08 09

Mean H-Band Ca-ordination

Deposit, publish, access and visualise structural data
Free functionality to share and learn from structures

CsSDCommunity.

Medicinal & Computational Chemists ¢ Crystallographers & Structural Biologists ¢ Solid Form & Crystallisation
Scientists ¢ Functional Materials Scientists ¢ Educators 4 Industry and Academia




Mercury - Structure visualisation

With Mercury you can:

« Explore crystal structures, molecular
conformations, crystallographic
olanes and simulated morphologies

« Generate high quality structural
Images for effective scientific
communication

» Output model files for 3D printing

« Analyse geometries, interactions and
the packing inside structures



Structure visualisation — Basics

What have we learnt in previous workshops and
resources?

« The basics of the Mercury interface.

» Basic options to visualise small molecule crystal
structures.

« Analysis and visualisation of Hydrogen bonds.

 Visualisation of the packing and basic symmetry.

« Creation of high-resolution publication ready
IMmages.

Mercury
Visualisation 101
¥4

m g @ oot o .

Downloadable {
training 31
module

stances, angles and tosions.
s work
—— Se|f_ Ulded
rrrrrrrr

||||||||

Short how- e
Lo Wiclsos (Offtes i

How to define and visualize
hydrogen bonds in Mercury - video...




Mercury Overview

Display
options to
visualise and
navigate

structures

o
@
F
@ AABHTZ (P-1) - Mercury — O X
File Edit Selection Display Calculate CSD-Community | CSD-Core CSD-Materials CSD-Theory CSD-Particle CSD-Discovery CSD Python API| Help
Picking Mode: | Pick Atoms » | Clear Measurements {b m |:| Show Labels for | All atoms with | Atom Label
Style: Balland Stick ™ Colour: | by Element or Suppression ™ Manage Styles... |Work b Atom selections: bed
l:‘ Animate. .. Default view: b ~| a b c a* b* c* X- X+ y- y+ z- z+ %90 x+90 yS90 y+90 z90 z+90 & > L T zoom- zoom+ [ Select by SMARTS:|[d]
Structure Navigator &
S——
AABHTZ e

Crystal Structures Spacegroup

AABHTZ P-1
AACANITO0 P21/c
AACANIT1 P21/c
AACFAZ Pbcn
AACFAZ10 Pbcn
AACMAL P21/c
AACMHX10 Pbca
AACRHA Pncm

Explore over AACRHC P

AACRUB Cc

1.25 million AACRUBO1  C2/c
AADAMC  P21/c
curated AADMPY P-1

structures AADMPYTO P

AADRIB P21
AAGAGGT10  P212121
Display Options g X AAGGAG10 P21
Display Options
<< ==
[ pading [ ] Short Contact < (sum of vdW radii) Contacts... show hydrogens || Depth cue _
I:‘ Asymmetric Unit I:‘ H- Bond Default definition I:‘ Show cell axes I:‘ Z-Clipping TrERlED
l:‘ Auto centre More Info v |:| Label atoms Stereo l:‘ Multiple Structures
Reset Powder... Structures...

Press the left mouse button and move the mouse to rotate the structure




CSD Refcodes AN o

What is AABHTZ?
A CSD Refcode
A database reference code

‘ Containing 6-8 characters
CSD Refcode - Used to identify entries in the CSD
JAVA\=1 ) o V4

Refcode families

* The same substances are assigned the same 6 letter code plus an additional 2 numbers
* Polymorphs
« New determinations or re-refinements of the same substance
- Determinations at different temperatures/pressures

« Stereoisomers or different solvates, co-crystals, etc are assigned different refcode families

Some of my favourite refcodes are: KITTEN, BATMAN, DISNEY, GAUTAM, GLYCIN ( :( :I >( :



Import and assign

l?or)d types and
Visualise your own structures missing hydrogens

(optional)

* File > Open —to open one of your own files for example a CIF

Auto Edit Manual Edit

« Edit > Auto Edit Structure to assign bond types

. . Guess bond types
e File > Auto Edit Structure on Load to automate O al

(® Only bonds with unknown types

& AABHTZ (P-1) - Mercury

File Edit Selection Display Calculate Edit Selection Display Calculate CSD-C
Standardise to Cambridge Structural Database
I Open... Ctrl+O I Undo: Packing off Ctrl+7 conventions
. . . Aromatic bonds
Recent Files » Redo: Not Available Ctrl+Y Delocaliced Bonde
Sketch Molecule... Ctrl+K Copy Image to Clipboard  Ctrl+C

Edit Structure...
Auto Edit Structure...

Auto Edit Structure on Load

Save As... Ct

Normalise Hydrogens... Add missing H atoms
POV-Ray Image...

Print in 3D...

Polymer Expansion...

Transform Molecules...

Apply | ‘ Close

Exit Ctrl+Q Change Spacegroup Setting...




@ ABEGIV (Phca) - Mercury

File Edit Selection Display

Picking Mode: | Pick Atoms

Style: |Ball and Stick  ~ Colour: | by Element or Suppression

Calculate

C5D-Community  C5D-Core

v | Clear Measur

Manage Styles...

CSD-Materials

Cards

[ show Labels

LV

C5D-Discovery

Atom selections:

All atorms

CSD Python AP1 - Help

with  Atom Label

Select by SMARTS:

Measure

Clear Measurements

Packing
Selection

Styles
Colours
Labels
Show,/Hide
Contacts
Picking Mode
View
Rotation Centre

Mew

Draw Backdrop

Display Options...

Are the aromatic
rings not showing?

Wireframe
Capped Sticks
Ball and Stick
Spacefill
Ellipsoid
Polyhedral

Stick settings...

Ball and Stick settings...
Spacefill settings...
Ellipsoid settings...

Polyhedral settings...
Contact settings...

Display Bond Types
Display Aromatic Rings

Highlight Acyclic Aromatic Bonds




Lost toolbars?

@ AABHTZ (P-1) - Mercury — m X
File Edit Selection Display | Calculate CSD-Community CSD-Core CSD-Materials CSD-Theory CSD-Particle CSD-Discovery »
Picking Mode: | Pick Al Styles 4 “lear Measurements @ﬂ @} D Show Labels for All atoms with »
Style: Capped Sticks Labels b ~ |- Manage Styles... |MyStyle ~ |- Atom selections: ~ |- Select by SMARTS: >
[ ] Animate... , , y-00 y+90 7z-90 z+90 *  Disorder:
Colours p » Display Options
Structure Navigator F X
' Graph Set ’
Show/Hide » rap 5 J — -
S 5 Interrmolecular Potentials Crystal Structures Spacegr ™
Searches AABHTZ  P-1
AACANIT0 P21/c
Symmmetry Elernents.., .
Post Search Opticns AACANITT P21/c
Yoids... AACFAZ  Pbcn
»"  Structure Navigator AACFAZ.. Pbcn
Display Opticns.., o AACMAL - P21/c
»"  Picking Toclbar AACMH... Pbca
Manage Styles... AACRHA  Pncm
»" Labels AACRHC P-1
. AACRUB Cc
View alon » Displ
I - e AACRUB... C2/c
Dial box... w"  Style Manager Toolbar AADAMC P21/c
AADMPY  P-1
g »"  Atom Selection Toolbar AADMP... P-1
plash screen
AADRIB P21
Toolbars B R Select by SMARTS AAGAG.. P212121
w’  Animation Toclbar AAGGA... P21
AALCFE  P21/c
. . v
Display Options »w’  Crystal Orientation Operations R =
Display
. Alignment and Orientation Qperations =2 P
[_] Packing ] v g 2}
= g Short Contact < (sum of vd' I v

Extra Tip
Click on the resize
icon or drag the top ,
to pop the toolbar

‘ I Structure Navigator

out.
ER

Extra Tip

To pop the toolbar
back in drag it to the

area you want it.
@ AABHTZ (P-1) - Mercuny

Picking Mode: Pick Atoms
Style: |Ball and Stick ~ Colour: by Element




Improve visualization with

lots of display options!

Display

I Styles ’ Wireframe
Labels 4 Stick
Colours ’ Ball and stick
Show/Hide ’ Spacefill
More Information  * Hlipsoid

Polyhedral

Symmetry Elements...

Voids... Stick settings...
Ball and Stick settings...

DEETAQ LTS Spacefill settings...

SR Ellipsoid settings...

View along g Polyhedral settings...

Sl e Contact settings...

~  Splash screen Measurement settings...

cliz g Selected  Calculate
Centroids...
Planes...

Colour: |by Element or Suppression ~

Packing/Slicing...
Contacts...
Molecular Shell...
Graph Sets...

view: b

by Symmetry equivalence
by Atomic displacement
by Symmetry operation
by Gasteiger charge

by Partial charge

by Element or Suppression

Powder Pattern...

Structure Overlay...

Molecule Overlay...




Working with colleagues and want o
consistent look of your publication images? .

@ 2BUIG (R-3c) - Mercury = m| X
@ Style Manager x & style Settings i
Picking Mode: | Pick Atoms SR I IR
Style: | Polyhedral ~  Colour: by}m Manage SWIEE. - M}'Stﬁl’IE Work | | Apply | . Style Colour |
]| Animate... | Default view: b o Ty Publication 4 I Atoms: Mon Hydrogen | Polyhedral ~ | By Element e
Presentation Edit... Atoms: Hydrogen Polyhedral ~ | By Element ~
e . ORTEP : ! c 7 Bonds Polyhedral ~ | By Connected Atoms ~
- _ _— E
AV A0 Print By Contacts: Hanging Stick ~ | M Red ~ 4
4 Woaork 2 Contacts: Expanded Stick w Cyan v !
Step 1: Create your < " :
p I Yy | MyStyle MNew... M [CellEdges Stick ~ | M Black v i
. b ' . . -
Centroids Solid ~ | [l Red ~ N
personalised style > ® Style name Open... |
| 3 Planes Solid ~ | [l Red w
—
Please supply a name for the style Save As... | Display Options... Change background, depth cue, labels, lighting, etc. ~o
|Research Project | | 18 '8
Element Colours... Change colours of commaon elements .
Symmetry Equiv. Colours... Change Symmetry Equivalence colours L
Delete \
Stick Settings. .. Change stick display options .
Close /
Ball & Stick Settings... Change ball and stick display options o~
Spacefill Settings. .. Change spacefill display options
Elipsoid Settings... Change ellipsoid display options -
Polyhedral Settings. .. Change polyhedral display options
Contact Settings... Change contact display options 1
Measurement Settings... Measurement options

Defaults



@ 2BUIG (R-3c) - Mercury

Picking Mode: | Pick Atoms

Style: | Polyhedral ~ Colour: by [Sem

el e L R

Manage Styles... 'MyStyle

1| animate... Default view: b

0 Style Manager

Work
Publication
Presentation
ORTEP

3D Print
Work-2

MyStyle
October
December
Research Project

MNew...

Open...

Save As...

Rename..

Delete

Close

0 Save As

T

Organise ~

@ This PC

« |mages_structures >

New folder

J 3D Objects

I Desktop

File name:

Save as type:

» Hide Folders

v

Research Project

Mercury Styles (*.msd)

Search images




Step 3: Your collaborators

can then open and save

your new style.

@ 2BUIG (R-3c) - Mercury

0 Style Manager

7

ORTEP
3D Print
Work-2
MyStyle
October

Picking Mode: | Pick Atoms lasell sl |7 T3
Style: | Polyhedral *~ Colour: by}m MEHEQE St!flEE. e M?St&"le Work
[0 animate... | - Default view: |b = T Publication

Presentation

December
Research Project

@ save As X

T « Images_structures * v ©  Search images Rl
Organise ~ New folder = - (7]
R This PC "
¥ 3D Objects
I Desktop

¥

File name: | {EEEI N o] [lu .

Save as type: Mercury Styles (*.msd) v

» Hide Folders 3 Cancel

2

O Open

Organise ~

W This PC

I Desktop
@ Docume

File name:

_J 3D Objects

I Nawnlnads

=
= @ Style Manager x
| Apply | Work | Apply_l
: Publication ;
Edit.. Presentation Edit...
Copy.. ORTEP Copy...
3D Print
Work-2
Mew... Mew
Open...
Save As...

T « |mages_structures > ~ ©  Search images

New folder

"] Research Project .msd

nts
v

‘Research Project .msd v ‘

S

(7] Close

Rename...

Delete




Visualizing disorder

- New functionality when you load a CIF into
Mercury:

« Visualise the different disorder models
* Visualize the contacts for each disorder model
* Visualize the voids for each disorder model
* Avalilable from July 2023 onwards

* More disorder work planned.

File Edit Selection Display Calculate CSD-Community  C5D-Core  C5D-Materials C53D-Theory  C5D-Particle  CSD-Discovery  C5D Python APl Help

Picking Mode: |Pi::|c Atoms w | Clear Measurements @ [] show Labels for | All atoms ~ with | Atom Label “ . ‘
Style: |Ba|| and Stick baluur: |I::|1,r Element e | Manage Styles... |Work ~ | - Atom selections: Select by SMAF‘.TS:| [c]

|:| Default'uiew: a b c a* b* = ¥- X+ y- y+ z- z+  x90 x+90 90 y+90 290 z+90 < = . T zoom- zoom+ Disorder: A@= All

CCDC




Change disordered atoms colours

@ PIVDEI (P21/c) - Mercury

File Edit Selection Display Calculate

Picking Mode: | Pick Atoms
Style: Ball and Stick  ~ C

@ PIYDEI (P21/c) - Mercury

File Edit S5election | Display Calculate

Picking Mode: | Pick Atoms
Style: Ball and Stick

1! Animate... | :Def

Colour:

Styles
Labels
Colours
Show/Hide

More Information

Symmetry Elements...

Voids...
Display Options...
Manage Styles...

View along

Dial box...

Splash screen

Toolbars

by Element or Suppression

E‘ Q} [] show Labels for 4l 2

Atom selections:

CSD-Community  CSD-Core  CSD-Materials  CSD-Discovery

b Measurements IEI ﬂ % [] show Labels for Al

4 Manage Styles... |Cards “ | © Atom selections:
+ Atoms... 1 x490
r Bonds...

Centraoids...

3
Planes...
Contacts...

Elernent colours...
Symmetry Equivalence colours,.,

Labels...

Background settings...

CSD-Community  CSD-Core  CSD-Materials  CSD-Discovery  CSD Python APl Help

=l
| =/l B v| | 5ol el e I O o cof

o Element Colour Opticns

1

Ll
| o] 2|
| = |
Bl o] | ®| | 0| 3| & o] 2| 10 5]
= & | ] ) e e

=| B o] bl ) O el ol
I | ) S
| ce| pr nal eml sm| e | Tl Byl Hol il
| [ S 0

Defaults

IIIIIIEEE
e

BB == E |7 2

Close

o [}
®
@
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®
.
°
.
d ®
® g A
o a
e
o ®

CCDC



View multiple structures

I Structure Navigator =
- : -

HXACAN10 Find Tick Multiple Structures to by Symmetry »
Crystal Structures Spacegroup " d isplay more than one . . by Atomic Displacement

HXACAN Peab structure. Untick Multiple _ | White

HXACANO1 P21/a structures to display one " Light Grey

HXACANO2 P21/c structure. " Grey

HXACANO3 P21/n Note: you will need to move to : ;ﬂr'l‘(GrEY

HXACANO4 P21/n another structure in the - Pizck

HXACANOS5 P21/a Structure Navigator for it to take ® Red

HXACANOG P21/a effect. ® Orange

HXACANO7 P21/n ™ Yellow

HXACANOS Pbca ™ Light Green

HXACANO9 P21/n o Multiple Structures X  Green

HXACAN10 P21/n Actions, e.g. packing, will be applied to Active structure(s) only ™ Light Blue

HXACANT1 P21/n Rotation is around ® Cyan

HXACAMN12 P21/n @ Global rotation centre O Local rotation centres H Blue

<< Delete Al All All All ¥ Purple
Tree View Structure  Visible Active Movable Colour " Violet
1 HXACAN by Element VE B Magenta
Multiple Structures M HXACANO1 |by Element y Custom...
Structures. . Custom Carbon...

"™Move the structure that is nearest the mouse cursor

CCDC
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@ OGUSIV (P-1) - Mercury

|
h

File Edit Selection Display Calculate lommunity CSD-Core CSD-Materials CSD-Particle CSD-Discovery CSD Python APl Help

P
. ¢
Picking Mode: | Pick Atoms Centroids... E”ﬁ”@” Show Labels for |Stereocentre5 v |wi1:h |Stereochemi5lry w | M O I e C u I e Ove r I a \
* Style: |Ball and Stick  (Colour: |by es... | SANZISTYLETEST || Atom selections: ~ ‘ Select by SMARTS [c] Ny -

Planes...

] Animate... Default view:[ - x ¥y y+ @ Automatic Molecule Overlay o zoomt+
Packing/Slicing... - When to use;
Contacts... Select two molecules (by selecting at least one atom in each) ® TO COmpa S the Ch|ra||ty Of
Molecular Shell.. atoms, an he same number of toms. At overay s comple stereochemistry of molecules.
Graph Sets.. you must select Reset before repeating the overlay or selecting
diferent molecules, « To compare conformers.
Powder Pattern.. What is does:
Structure Overlay.. Results « Uses inversion and flexibility to
.I Molecule Overlay... Flexibility Inversion  RMSD : Display calculate overlays.
® .
k _ - What you can use it on:
X o « 2 molecules in different structures
X X O « Or 2 molecules in asingle structure.
O

Original  Geometry ----

« On identical or non-identical
molecules.

Tip

« |f the reported RMSD for the
overlay is quite low, but the Max. D
value is large, it may be an
indication that the molecules are
quite similar, except for a localised
area.
For example, a comparison of cis
and trans geometries may result in
a low RMSD but high Max. D.




Structure Overlay

Tick Multiple structures to

load more than one structure
CSD Refcodes: VIRAZL, FOQROU

(light blue — pink)

Structure Navigator g X
VIRAZL Find
Crystal Structures Space:

VIRAZL P2121.
VIRAZLO1 P2121,
VIRBAA P21/m
VIRBAB P21/n
VIRBAZ P-31c

VIRBED p-1 v
< >

<< ==

Tree View

Multiple Structures

Structures...

Calculate  C5D-Community

Centroids...

Planes...

Packing/5licing...
Contacts...
Molecular Shell...
Graph Sets...

Fowder Pattern...

Pore Analyser...

Structure COverlay...

Molecule Overlay...

& structure Overlay

Select pairs of atoms in any two crystal structures.

Atom1 Atom?2 Distance

N3 0.010

elete N3 N5 0.001

3 | Delete N1 N2 0.010

RMS: 0.00795

Close




@
@ AABHTZ (P-1) - Mercury - O X
File Edit Selection Displa Calculate cop community  CSD-Core  CSD-Msterials CSD-Discovery  CSD Python APl Help &
2
Picking Mode: Expand Contacts Centroids... asurements {b p [% I:‘ Show Labels for | All atoms with | Atom Label
F 2]
Style: | Ball and Stick * Colou P Iﬂnes_" Manage Styles... |Publication | Atom selections: b &
[]  animate... Defailt vie : L. x- X+ y- y+ z- 7+  x90 x490 y90 y490 790 2490 & @ .
Packing/Slicing...  pacing and icing
Packing Indude atoms
CDntaCtS Show cell axes ... that Fit
M Dlecular S he" Label cell axes ... in molecules whose Centroids fit

... in molecules where Any atom fits

O0O®O

Graph Sets... a -

... in molecules where All atoms fit

Powder Pattern...

Structure Overlay...
Molecule Overlay... [EEE Reset 333

Slicing

D Show sliceé T|Ck tO ShOW Sllce
Select plane: | [ (-1 (U ﬂtICk paCklng fOI’ Clarlty) Show plane

p I [ J S : New... Edit... Delete Show bounds

FY
Depth: 10.00 -
Dicplay Cnti Area: 20,00 :
isplay Opticns
Display Options Displacement: 0,00 :
«*| Packin - ~| Show hydrogens Depth cue Reset
|. D Short Contact < (sumn of vdW radii) Contacts... b=d |:| .
I:‘ Asymmetric Unit H-Bond Default definition I W | Show cell axes II:‘ Z-Clipping
0K
I:‘ Auto centre Mare Info b I:‘ Label atoms Stereo
. TFILTOEE STUCIOrEs
Reset button: . —

Reset a fr|e N d | Structures. .. | >
L ]
Click on a red contact to see the whole molecule




@
Selectplane: | W (100) BFDH relative area: 0,181 “
hd ot (100) BFDH relative area: 0. 181 -
B (-100) BFDH relative area: 0.181
Bl (0-10) BFDH relative area: 0.159
O Packing and Slicing
Packing Inchiie sk I (101) BFCH relative area: 0.043
Il (-11-1) BFDH relative area; 0,036
Slicing Bl (1-11) BFDH relative area: 0.036 hd
[+] show slice
Selectplane: | W (100) BFDH relative area: 0.181 v| 4 show plane

[+] show bounds

Q Properties

$ Depth:

] )
Area: I - [] show
| ==) 000 &

Displacement: [ Label |BFDH relative area: 0,181

[+] Transparent

Colour: E




A reminder: BFDH Morphology

@ AABHTZ (P-1) - Mercury - O ®

CSD—PEI'IZICHE Cs0- DISCWEIF CsD P!'fthﬂﬁ AP C5D-Materials | CSD-Theory  C5D-Particle  CSD-Discovery  C5D Python APl Help

y+ z- 7+ x-80 x+480 y90 y+90 z-80 z480 & > J T zoom- zoom+ i Sﬁp Planes... hHRE'I[C]i

Structure Navigator & X ] MOPAC...
o Surface Analysis... . ment ¥
E'i‘ ‘:_ _} \L-' T ] UNI Intermolecular potentials...

Crystal Structures Co-Crystal Design 3 I
AABHTZ . ' r - - ~

AACANND

AACANIT . — XN
AACFAZ
AACFAZ10 ' Mﬂlphﬂlﬂgjl' X \d /

AACMAL
AACMHX10
AACRHA

wacaus A show Marphology
oy Scale factor: [ 100 | [ Auto scale Display Options

AAGAGE10 [ Show (k) labels

AAGGAGTD

AALCFE

AALPRO

o [] Draw faces Colour | = | ' 0.5
AAMTCO

AAMTCO10
AAMTIP [] shadows
AANHOX

AANHOX0
5 || oo i [0
AAPUNI

AAPYPE .
AAREOK [ Fill morphology with molecules
AAXTHP

AAXTHPO1
AAZDCO

ABABAH

£ o= s
ABABAK _ -
ABABEL
ABABEM

ABABIQ
Display Options 8 x| ABABIR v
Display Options

[ racking [ Short Contact < (sum of vdW radi) gxz":’s g':z:: ] Tree View Save and Load

[ asymmetric Unit | H-Bond User defined
[] Auto centre [] Label atoms || sterea [] Multiple Structures.

== v
Press the left mouse button and move the mouse to rotate the structure 4
L]

File Edit Selection Display Calculate CSD-Community ©CSD-Core CSD-Materials CSD-Theory (CSD-Particle CSD-Discovery (CSD Python APl Help

Select by SMARTS:|[d]

s BFDH has moved to the C5D-Particle menu
i} ‘ Animate...

||5Dehltmew:b v abca b




Calculating planes e

@ HXACAN (Pcab) - Mercury

Picking Mode: Lasso Atoms
Style: Ball and Stick hs
l:‘ Animate. .. Defal

0 Planes

Pick an object from the list below, or in the graphics window, or right-
dlick on a list item

Eile Edit Selection Display Calculate CSD-Community C5D-Core  CSD-Materials  CSD-Discovery  CSD Python APl Help

Centroids...

~ | Clear Measurements @ @ D Show Labels for | All atoms with | Atomn Label

h¥ Manage Styles... |Publication b Atom selections: h¥

Planes...

a* b* = x- X+ y- y+ z- z+  x-80 x+90 y-90 y+80 z-80 =z+90 < > ). T zoom- zoom+ @ Selectby SMARTS:

Packing/Slicing...
Contacts...
Molecular Shell...

Graph Sets...

Powder Pattern...

@ Plane Properties

Mean plane hkl

Select at least three atoms to
calculate least squares plane:

I Pick atom to select:

Edit... Delete () Picked atom

O Picked molecule

I MNew Plane...

Al
Non-hydrogen

Hydrogen

Shaw

X jre @ Plane Properties

Mean plane hkl

le

Create Miler plane:

Colour:

Label |mean:

Powder...

Miller indices
=] <] ] |
g X

show Options
Label ‘(000)
. Contacts. . Show hydrogens |:| Depth cue
Transparent Show cell axes l:‘ Z-Clipping
Colour: MoreInfo v D Label atoms Stereo

Press the left mouse button and move the mouse to rotate the structure




Calculating planes e

@ HXACAN (Pcab) - Mercury

Eile Edit Selection Display Calculate CSD-Community C5D-Core  CSD-Materials  CSD-Discovery  CSD Python APl Help

Picking Mode: Lasso Atoms Centraids.. ~ | Clear Measurements {]'_f"] @ @ D Show Labels for | All atoms with  Atom Label

Style: Ball and Stick b Planes... hs Manage Styles... |Publication b Atom selections: h¥

l:‘ Animate. .. Defal a* b* * x- X+ y- y+ z- z+  x-80 x+90 y-90 y+80 z-90 z+80 & = | T zoom- zoom+ Select by SMARTS:

Packing/Slicing...
Contacts...

Molecular Shell...

0 Planes

Pick an object from the list below, or in the graphics window, or right-
dick on a list item

Edit. ..

Close

Delete

Tick
“Transparent”
to see through
the plane

Graph Sets...

Powder Pattern...

@ Plane Properties x U @ Plane Properties

Mean plane bkl

Select at least three atoms to
caleulste least squares plane:
Pick atom to select:

() Ficied atom

() Ficked moleauie

Mean plane

Create Miller plane:

Miller indices.

Nen-hydrogen

Hydrogen

o Show

Label [mean: ‘ Label |(ooo)
Transparent Transparent Options
Colour: Gl Contacts Show hydrogens |:| Depth cue

Show cell axes l:‘ Z-Clipping

oK Cancel
D Label atoms Stereo

More Info o

’ Powder...

Reset

Press the left mouse button and move the mouse to rotate the structure




Exploring Molecular Shells o

Molecular shells
contain atoms within
a set distance from a
selection (in some
fields: “coordination
sphere").

@ HXACAN (Pcab) - Mercury

Eile Edit Selection Display Calculate CSD-Community C5D-Core  CSD-Materials  CSD-Discovery  CSD Python APl Help

Picking Mode: Lasso Atoms i Clear Measurements @ @ D Show Labels for | All atoms with | Atom Label
Centroids...
Style: Ball and Stick b hs Manage Styles... |Publication b Atom selections: h¥
Planes...
l:‘ Animate. .. Defal = x- X+ y- y+ z- z+  x-80 x+90 y-90 y+80 z-80 =z+90 < > ). T zoom- zoom+ @ Selectby SMARTS:

Packing/Slicing...
Contacts...
Molecular Shell...

Graph Sets...

@ Molecular Shell
Generate all molecules that contain an atom within the following
distance of the selection:

Contact distance range

@ Actual distance O Vdw distance

Powder Pattern...

Structure Owverlay...

Molecule Overlay...

FS
Minimum ‘D.DD v|
FS
Maximum ‘3.00 =

Show contact lines Label distances

Mote that you can shift-dick on atoms and bonds to select and de-select whole molecules

| [ o

ns g X
Options
/| Show hydrogens Depth cue

P D Short Contact < (sum of vdW radii) Contacts... M YOrog |:| P

! petcUnt |1 H-Bond Defautt definition show cellaxes [ zloping
lentre MoreInfo v D Label atoms Stereo
Powder...
et
ouse button and move the mouse to rotate the structure




Selection  Display Calculate CS5D-C

Select Al Ctrl+A * CSP Refcode
Select Molecules... ‘ | FOQQOT

[ [
Select tips | s
p Select
Deselect All Ctrl+D
Dezelect Molecules...
Dezelect Atomes...
Picking Mode: |Lasso Atoms L Deselect

Inwvert Selection Ctrl+|
Expand Selection Ctrl+E

Save Current Selection...




L I
° @
Select Tips ‘. v
e L g . o
Selection 5 A § . o .
Select All Ctrl+A b L j J N -
Select Molecules... o .
Select Atoms... 3 » y 1‘-;) '
Select ’ Select Hydrogen o G
Deselect All Ctrl+D Select Non-Hydrogen @ “ ]
Deselect Molecules... Select Carbons & =.;; S ¢
Deselect Atoms... Select Non-H, C @ '- 15 ’
Deselect 4 Select Metal Atoms i Q6
Invert Selection Ctrl+I Select Non-Metal Atoms (' w
Expand Selection Ctrl+E Select Contact Atoms

Save Current Selection... Select Stereocentres




9 FEFLOT (P21/n) - Mercury
File Edit Selection Display Calculate CSD-Community CSD-( - CSD-Di r CSD Pythen APl Help
Picking Mode: | Pick Atoms Eme % || : [ Show Labels for |MNon-hydrogen at

ticks “~ Colour: by Element yles... S ~ || Atom selections:

Default view: b c C X- X+ Y-y -+ x-90 w490 y-90 y+9

ct by SMARTS: ‘ ct by SMARTS:




Missing information?

File Edit Selection

Display Opticns

Display

[ Packing

|:| Asymmetric Unit
|:| Auto centre

Reset

@ OLOFUQ (P-1) - Mercury

Display Calculate

C5D-Community  C5D-Core

CSD-Materials

Contacts...

[] Shert Contact
[J H-Bend

< (sum of vdW radii + 0.14)
User defined

.I I More Info - I

Powder. ..

Press the left mouse button and move the mouse to rotate the structure

C5D-Discovery  CSD Python APl Hely

ture: | OLOFUG

Customise...

0‘ Customise

Available Ttems (Right-dick for options)

Batch
Remarks
v Chemical

{Bioactivity

Conformer
|somer
Source
Peptide Sequence
Classifiers
“  Crystal
Color
Habit
Analoagues

B =]

<< Remove

Selected Items (Right-dick for options)

Identifier ~
Literature Reference

Formula

Compound Name

Synenym

Space Group

Cell Lengths

Cell Angles

Cell Volurne

Lz

R-Factor (%) W

Up Down

4

Diagram
Atoms Formula
Bonds

Contacts

Centroids
Flanes Synonym
Symmetry

Distances

Literature Reference

Compound Name

5010827010301789X

ct.C:Cryst.Struct.Commun. (2003), 59, 0583, doi:10.1107/

CogHia N O4 ", CH Oz \CaHe Oy

9,10-Dimethoxy-2,3-methylendioxy-5,6-dihydrodibenzo
(a.g)guinolizinium formate succinic acid

Berberine formate succinic acid; PDB Chemical

Component code: BER

Angl . -
= Bicactivity

Torsions

All Angles

berberine is an antimicrobial agent used for the
treatment of eye infections, gastrointestinal disorders

and other diseases

All Torsions

Close




Save your current display

| @ VUME (P21/n) - Mercury

F|Ie‘ Edit Selection Display Calculate CSD-Community CSD-Core CSD-Materials CSD-Discovery CSD Python APl Help

Open...

Recent Files
Sketch Molecule...
~  Auto Edit Structure on Load

Save As...
POV-Ra

File name: |

Ctrl+O

Ctrl+K

Ctrl+S

pasurements @ Q @l} [ show Labels for Al atoms

Manage Styles... |Cards ~ | Atom selections:

N,

with 'Atom Label
v | Select by SMARTS:[[c]

= X- X+ y- y+ z- z+ %090 x+90 y90 y+90 z90 z+90 <« - LI T zoom- zoom+

File Edit Selection Display Calculate C

Open... Ctrl+-O e
Recent Files r
Sketch Molecule... Ctrl+ K

SMILES to Maolecule... Ctrl+Alt+ M

Auto Edit Structure on Load

Save As... Ctrl+5
POV-Ray Image...

Print in 30...

Exit Ctrl+C

» Hide Folders

Save as type: Mercury compressed XML crystal files (*.mryx)

Save

Cancel

..and reopen it later!

CCDC



Mogul can display
distributions of
important molecular

CSD-Conformer Generator e bond longins,
= angles, ring geometries,

and torsions of the
expertly curated

« Part of CSD-Discovery, CSD-Materials and CSD-Enterprise suites structures in the CSD.

« The starting point are Mogul data libraries with some changes and improvements to
tailor them to conformer generation )

o 20221 release of Conformer Generator version: improved handling of flexible ring .
systems

« Using Mogul templates for isolated, fused, spiro-linked and bridged rings

* Ifnotemplate available, then generated on the fly with cyclic bond rotamer
distributions

* Fast & chemically plausible conformations

* Initial optimisation step also useful to prepare compound libraries before virtual
screening

Knowledge-Based Conformer Generation Using the Cambridge Structural Database. < < I N

Cole J.C,etal. J Chem. Inf. Model. (2018), 58, 615-629.



Molecule

get rotamer sample and
and ring score
distributions conformers

select diverse
subset

400

Freguency

] [
Rotatable bond probability distribution
Rotatable bond frequency distribution '| ST
o4 = Torsion angles

_ Qm selectedin

£, 3r probability order

o

J ¥ Unusual
180 120 60 0 60 120 180 ¢ 180 120 80 ) 60 120 180 threshold o
reduce conf

Reference torsion angle

Reference torsion angle

space

Overall conf prob
(score) p =p1 P2 P

CCDC



CSD-Conformer Generator: Latest validation

L
'y
® y ®

« Performance evaluated against the Platinum™* diverse data set - get fast & chemlcally

plausible conformations

Top n conformers

n o 50 250

least ARMSD <05 A (%) 18 57 66

least ARMSD <10 A (%) 39 84 92
mean ARMSD 0.59 0.48

Percentage of Data Set

1 2 3 4 5 [ 7 8 9 10 11 12 13 14 15 16

Number of Rotatable Bonds

----- 50 conformers, ARMSD <= 0.6 -----50 conformers, ARMSD <= 1.0
—— 250 conformers, ARMSD <= 0.6 —— 250 conformers, ARMSD <= 1.0

Elapsed time (s)

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Number of Rotatable Bonds

Benchmarking Commercial Conformer Ensemble Generators
Friedrich N.-O., et al. J. Chem. Inf. Model. (2017), 57, 2719-2728.

Celdanamycin, 19 atoms in ring
(PDB 3C11): top 50 cqnformers,
least AMRSD = 0.95 A

CCDC

(=)



No Coding? No problem! el

D

e

Molecular Geometry Report for HXACAN CC DC \ @
0 HXACAN (Pcab) - Mercury — O x ‘ Molecular Analysis @
File Edit GSelection Displa Calculate  CSD-Communi C5D-Core  C5D-Materials  C5D-Discove CSD Python AP Hel
= = s~ i = = = v " ner crystal_structure_report.py
ikl : Lasso Atoms hY F M r &1} . ®
Picking Mode Clear Measurements Anal}rys » "
molecular_geometry_report.py
Style: Ball and Stick * Colour: by Element h4 Manaage Styles... |Puk R s » Crystal Structure Report for HXACAN (@ I ) (
| epo - N\t :
l:l Animate... Default view: b ~ | a b c a* b* X- X+ y- ¥+ z- 1 : h , qmck_g E':'m'atr}r—r-hec k.p}f Crystal Structure Analysis
Edrcnes
quick_packing_check.py
user_support.py
simple_report. MeCO,
welcome.py PIe_reportpy
= rebond acceprors HN OH
# Rotatable Bonds
R R Fraction N,O Atoms
calculate_CSD_diversity_score.py Fraction Halogen Atoms
Bond Lengths
o Fltll:lﬂi... atom 1 atom2 Figure 1. Diagram for HXACAN
c2 C1
. =3 = Table 1. Selected Crystal Structure Information
CSD Python AP| Documentation = = Frp— HXACAN
:: C“: Formula C8HS N102
CsD Py‘thu:un APl Forum 5 = Space Group Pcab
£ < Cell Lengths [A) a11.8050 b 17.1640 ¢ 7.3330
le :: Cell Angles (°) 0 90.00 B 80.00 y 50.00
oz El Cell Volume (&) 1497.98
= il R-Factor 7.70
Bond Valence Angles
Volume and Packing Analysis
Atom 1 Atom 2
cs c1 c2 Table 2. Crystal Packing Information
2 €1 HL Estimated volume from 18 A® rule 1584.0
= = " exp I volume 1457.977
<3 c2 C1
c2 c3 ca Packing coefficient 0.69
= kel C CSD average packing coefficient for organic molecules 0.68(4)
o1 c4 3
oL = = Calculated void percentage™ 0.0
5 cs o2 Calculated void volume?® 0.0
Display Options g X = i) L
0z c7 cs . .
Display = = — Fractional Atom Coordinates
. . oz = L
M Packing H:| Short Contact < (sum of vdW radii) Contacts. o1 NL o7 Table 3. Atomic Coordinates
ssymmetric Unit. ™ 4 Bond Defauit definition ] Atom x ¥ z
[ ] Autocentre More Info c1 0.446 0.339 0.291
c2 0.333 0.337 0.212
it Powder.. c3 0.279 0.268 0.207
ese
ca4 0.324 0.201 0.281
Press the left mouse button and move the mouse to rotate the structure




Generating high quality images G

= < e e N . 0°
Width (pixels)  |4000 | Height (pixels) . - S
Material Properties ‘Standard Mercury " File Format PNG ~ ) . =
Background ‘As Mercury " Custom Color I: | | e > DO\/_ Ray | m a g e

|:| Generate Animation Frames

Rotate around X y z Chaﬂge R@SO'LIUOH

Clpen... Ctrl‘l‘D Number of Frames 30 .
Width = 4000 ®
| preview Height = 3000

File Edit Selection Display (

Recent Files b

Save As... Ctrl+S Preview

& Change 'Materia

Properties’ to ‘Metallic’

Printin 3D...

Settings

POV-Ray Executable }ovray—S.7.I}.I}fbinfpvengine.exe|
Qutput Directory |C:f Users/ward |

In order to run concurrent rendering or generate preview images

whilst a render is running, it is necessary to enable multiple p reSS ‘ p re\/| ev\/

instances of POV-Ray. To set this uncheck the "Keep Single

Exit Ctrl+Q

Set ‘Background' to
Transparent’

Instance” option in the "Options" menu within the POV-Ray user
interface.




3D printing

@ 3D Printing ot
@ ACEPOO (P21/¢) - Mercury
File Edit Selection Display Calculate C File Format  |VRML (colour) v
Dutput Size (mm): 38w x 47dx 496 h
Open... Ctrl+O Scale (mm/&) |4.IIJ = | Thinnest cylinder {mm}: 0.80
Recent Files 3 Smallest sphere (mm): 2.40
Generate Support Framework
Sketch Molecule... Ctrl+K
SMILES to Molecule... Ctrl+ Alt+ M e {'E'} I T T T S T T T B B B 0.8
AUtD Edlt Stru cture on Lﬂad |:I:I|LJITIFI REdiUS {'8'} (T T T O R T T T T T O S T T SO O T 0.5
Save As.., Ctrl+5 DOutput saved as N _Images/30Print\ACEPOO. wrl'
POV-Ray Image... Close
Print in 30...
Exit Ctrl+Q Settings
Cutput Directory . :,."ImagesfSDPrintl Browse. ..

Print with your 3D printer
or at a 3D printing service!

Example of 3D printed structure of

CSD Refcode SAHYIK

CCDC



Advanced Edit Features

S Change Spacegroup to Subgroup X

Entry

ESTROMN10 b

Current Spacegroup

P 2y 2424 (19) setting 1

Available Subgroups

P 1121 {4) setting 2 [1/4,0,0]
P 1121(4)setting 2
P 21 (4) setting 1 [0,0,1/4]
P 2111 (4)setting 3 [0,1/4,0]

= T | AEETY

Undo: Not Available Ctrl+Z
Redo: Not Available Ctrl+Y
Copy Image to Clipboard Ctrl+C

Edit Structure...

Auto Edit Structure...

Edit Bond Distance Limits...
Normalise Hydrogens...

Polymer Expansion...

Transform Molecules...
Change Spacegroup Setting...

Invert Structure

Change Spacegroup to Subgroup...

Edit Selection Display Calculate CSD-Commu

G Transform Molecules

Active Structure

Transform
FAZHETO1 M
Copy
Symmetry Cperators
Choose an operator below and dick Transform to move all molecule(s), or dick Copy Close
to create a transformed copy of all molecule(s). Or select an atom in one or more
molecules to apply the transformation to those particular molecules.
Crystal Symmetry Operators Inversion & Translation
XY.Z
1/2-%-y1/2+z
%, 1/2+y,1/2-7
1/2+x1/2-y,-z
Unit Cell Translations
Reset unit cell translations to zero automatically after copying or transforming

9 G Change Spacegroup Setting

Entry

FACROQ

Space group Setting

1: Hexagonal Axes (R-3)

1: Hexagonal Axes (R-3]
2: Rhombohedral Axes (R-3)

Standardise oK Cancel




Surface Analysis with CSD-Particle

Want to explore more? o b

ey >
On-demand training resources %ﬁ

>

Start the CSDU module! .

Community

Free Online Courses cSD-Particle

Self-Guided Workshops

Education and Outreach Training and Support Videos

Events

Free Products

Measuring Distances

Training and Learning




Free online training courses

\.

CSDU

On-demand modules to
learn how to use the CSD
software at your own pace.

Mercury Python \epbcsp GOLD
API Docking
4 & Y Q.
Mogul FIMs Particle

With
completion
certificates!

J

\

Helping you to learn:

* The basics of Mercury software.

« How to explore and pack
structures.

* How to create high resolution
Images.

https://www.ccdc.cam.ac.uk/community/training-and-learning/csdu-modules/

Helping you to learn:

* The basics of CSD-Particle.

* How to perform a surface
analysis.

* How to visualise likely
Interactions with the surface
using Full Interaction Maps
(also a CSDU course!).




CCDC
VIRTUAL WORKSHOP

In-Depth
Comparison of
Polymorphic
Structures Using
Mercury

=== Tuesday, 14th May
) 10 am (BST)

SSS

https://www.ccdc.cam.ac.uk/community/events/

And morel!

CCHE

Innovation in
Discovery Science

Virtual
Thursday 9th May o
9:30am-3:30pm BST

CCDC discovery science software users and non-

users will collectively discuss the latest trends and

advancements in the industry, including the rise of
Al and machine learning.

Use cases will be presented and common
challenges discussed.

CCDC
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